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1.0  Introduction 

The Journal Program is designed as a free-text information manager.  Information can easily be typed 
directly into a journal topic, retrieved from the Clipboard or imported from existing disk files.  Information is 
stored in up to 400 topics.  Topics are stored in up to eight different  Categories.  This is analagous to a file 
cabinet; the categories being the drawers, topic titles the individual file titles, and the text to the information 
within a file folder.  The topic titles are displayed in a listbox at the left  of the screen and the information 
associated with that title in a text box.  Topics can be easily moved from category to category.  The date the 
information is input into Journal ia automatically  (default mode, can be turned off) appended  to the 
beginning of the titles.   Search features allow quick searches for key words in any topic title or in the text of 
the currently selected category.  Keywords are not required as Journal treats every word as a key word.

A DAILYCLP Button is always displayed and can be used to grab text currently on the Clipboard and add it 
as a new topic to the currently open Category. 

Important Restrictions:  Windows Enhanced Mode Required.
Windows should be operating in the Enhanced Mode to run this program.
While the program will run in 2MB (you should set the capacities to 250KB), 4 MB is highly 

recommended.

The following files MUST NOT be edited or moved separately: JOURNAL.DAT, JOURNAL.INI, ANOTE.JOU 
through HNOTE.JOU and ANOTE.BAK through HNOTE.BAK.  All of these files MUST BE KEPT 
TOGETHER  at all times.  They can be moved to another machine ONLY if ALL are moved together.  If you 
want to move individual categories see How to Remove Categories to FIle and  How to Add Categories from
File.  

It is important to appreciate the difference between adding new categories with Journal using the Configure 
Categories from the Topics Menu AND adding new Categories from file.  All categories must be created 
within Journal.  Remove to File and Add from File, under the File Menu, provides the capability to save and 
restore categories created by Journal.

Program Capacities 
Categories: 8 **.   The first is initally titled as DailyJou (this may be changed) and is the 

` opening default category.  The titles can be configured by the user.
Topics:  400 per category 
Topic text: Maximum of 30K per topic.  The sum of information in all topic text fields of an 

individual category is user configurable from 250K to 4 MB.   They are 
all initially configured to 1 MB.  

**  Additional categories may be saved to disk, only 8 can be active in the program at any one time.  See 
instructions under the File Menu, Remove Category to File and Add Category fm File.

2.0  Getting Started

Program Files:
Journal.exe Main Program File
Journal.hlp Windows Help File for Journal
Muscle.vbx Required DLL
Threed.vbx Required DLL
VBrun100.dll Required DLL (NOT DISTRIBUTED WITH THE PROGRAM)



Commdlg.dll Required DLL (NOT DISTRIBUTED WITH THE PROGRAM,part of 
Windows 3.1))

Journal.wri Program Manual
Files Created by the Program (all in the program subdirectory.  These files SHOULD NOT be edited with 
another file editor as this would destroy the structure making them unusable within Journal)

Journal.dat Created the first time the program runs.  Holds topic titles.
Journal.ini created the first time the program runs.  Holds session to session 

configuration data.
Journal.bak Journal.dat backup, created when you choose BACKUP FILES
Anotes.jou Topic text for the first category
Anotes.bak Anotes.jou backup, created when you choose BACKUP FILES
Bnotes.jou, etc same as for Anotes.jou, Anotes.bak
Catagoryname.jtx Category saved to disk index file
Categoryname.jtt Category saved to disk data files

Installation:

Quick Instructions for Experienced Users:
1.  For the program to run you must have Vbrun100.dll and Commdlg.dll installed in either the 

Windows or Windows\System subdirectories.  Vbrun100.dll is available on numerous bulletin boards, if you 
are unable to locate, contact the author.  Commdlg.dll is distributed with Windows 3.1

2.  Copy Muscle.vbx and Threed.vbx to either your Windows or Widnows\System directories.
3.  Copy Journal.exe and Journal.hlp to the desired program directory.  I recommend a separate 

subdirectory for the program.

Detailed Example Installation
To install the program using the Windows File Manager:

1.  Open two windows in the File Manager (Window-New WIndow).  
2.  Set one window on the subdirectory where where the program files to be installed are located.  

This is the subdirectory in which the files are located after you "unziped" them.  This window will be referred 
to as the "SOURCE" window. 

3.  Set the second window on the directory under which you want to create the Journal Program 
Directory.  For example, if you want to install Journal in C:\journal subdirectory, then set the window on the 
C:\ root directory by clicking on the C:\ at the top of the directory tree.  If you want to install Journal in C:\
Windows\journal then click on the C:\windows subdirectory.  This windows will be referred to as the 
"DESTINATION" windows.

4.  With the focus on the DESTINATION windows, click FILE Menu and select Create Directory....
In the popup dialog box type: JOURNAL.

5.  In the DESTINATION window directory display, click on the JOURNAL directory window to 
switch the DESTINATION window to the JOURNAL directory.

6.  In the SOURCE window, click on JOURNAL.EXE.  While holding down the Ctrl button, click on 
JOURNAL.HLP.  Release the control button.  This should select both files.  Press down the Ctrl button and 
"drag" the selected files to the DESTINATION Window.

7.  In the DESTINATION windows directory tree click on either the Windows directory or the 
WIndows\System (preferred) directory.  This will change the DESTINATION window directory.

8  In the SOURCE windows, click MUSCLE.VBX.  Hold Down the Ctrl button and click 
THREED.VBX.  Release Ctrl.  This will select both files.  Hold down the Ctrl button and "Drag" the two files 
to the DESTINATION window

9.  Return to the Program Manager.  Select the Group in which you want to install the JOURNAL 
program icon.  

10.  Select File Menu.  Under the File Menu, select NEW...
11.  In the New Program Object dialog box, select Program Item(default) and click the OK button.
12.  In the Program Item Properties dialog box, press the TAB key to move the cursor to the 

Command Line selection.  Then click the Browse Button.  In the Browse files dialog, move to the JOURNAL 
directory and double click on JOURNAL.EXE.  This will return you to the Program Item Properties dialog 
with the Journal.EXE program in the Command lline.

13.  (Win 3.1)  Click the mouse in the Working Directory dialog box.  In this box, type the path to the
Journal Directory.  This will establish that directory as the start up directory for JOURNAL.

14.  Click the OK button to complete.

NOTE:  IT IS VERY IMPORTANT THAT JOURNAL STARTS WITH THE STARTUP DIRECTORY 
PROPERLY SET.  IT USES THE STARTUP DIRECTORY TO LOCATE ALL FILES.  WINDOWS PROGRAM 



MANAGER ALLOWS DESIGNATION OF THE STARTUP DIRECTORY.

3.0  Quick Start

1.  Double click the JOURNAL icon to start the program.  The FIRST TIME you run the program, a 
dialog box will popup informing you the initialization file is not found.  That's because you haven't created 
one yet.  Click YES to proceed.  (Note:  If you see this dialog box after having run the program once, then 
most likely you are not starting the program from the JOURNAL directory.  Check the dialog box for the 
startup program directory.)

2.  When the program starts, in addition to the main program screen, you will see a standalone 
button labeled DailyClp.  The menu bar caption for this button has the same label.  This button is used to 
"Grab" text on the Clipboard and eother add it as a new topic or append it to an existing topic in Journal.  
Whenver text is on the CLipboard, which you would like to save in Journal, click this button.  The button 
menu bar caption changes to show you the size of the text selected from the Clipboard (Journal text is 
limited to 30K) and a dialog box pops up for you to type in the topic title, if adding a new topic, or to select an
existing topic if you are appending the Clipboard to an existing topic.  If you want to add the Clipboard as a 
new topic, either type in the title desired or accept the default and click OK.  This is added to the currently 
selected Category in Journal.  If you want to add the CLipboard to an existing topic, click the Append Button 
and another form opens.  In the listbox, select the desired topic and click OK.  This will append the data.  
The DailyClp button  is the easiest way to transfer text information from any windows application to Journal.  
This works equally well with the Journal program in an icon.  When Journal is iconized, the currently 
selected Category is displayed as the caption.  The button remains and can be used as described above.  
The button can be moved by dragging the Menu Caption.  Journal remembers the last button location from 
session to session.

3.  Within the Journal Program, to set up the Categories, click the Topics Menu - Configure 
Categories.  Complete the dialog screen that comes up and select OK.  This will place the Category titles on
the button across the top of the screen as labels, it will also add these captions to both the Switch and 
Transfer Menus.  Category maximum capacity is displayed.

4.  To switch categories, click the applicable button or use the Switch Menu and select the category
desired.

5.  To add a new topic, click the New Topic button OR, select Topics Menu - New Topic OR, use 
keyboard shortcut Ctrl + N.  To Delete a topic, same choices apply only use Delete Button, Delete Topic and 
keyboard shortcut is Ctrl + D.  Ease of both adding new topics and deleting topics is available because 
routine housekeeping is as important as keeping new information.

6.  When new topics are added, today's date is automatically appended to the start of the title.  If 
this is not desired, it can be turned off by selecting Topics-Date Stamp On to remove the checkmark 
indicating the option is not selected.

7.  To import an ASCII file from disk (capacity limited to 30K), select File-Import.  This brings up a 
standard Windows file open dialog box.  Note:  this action makes a copy of the file and adds it to the Journal 
database.  To export a file, choose File-Export and type the complete path and filename desired.

8.  To Find information within Journal, click the Find Menu.  This will open another dialog.  Enter the
search text and the click either the Topic Titles or Text Search buttons.  The Next Text button (shortcut: F5) 
finds the next location of the search text within the SAME topic.

9.  Most of the rest of the commands are standard Windows commands except for three additional 
commands under the separator bar in the Edit Menu.  Strip CrLf will strip CrLfs from the selected text.  You 
must select text prior to using this option.  This is very useful when bringing in text, either via File Import or 
the Clipboard, which has embedded CrLfs.  Copy All places a copy of the entire topic text on the CLipboard. 
This is very useful for copy an entire topic to another application or making a duplicate copy of a topic.  Cut 
All-Del Topic copies the entire topic text to the Clipboard AND deletes the topic from the Category.  This is 
most useful when you want to combine two topics together.  Select the one you want to delete, then select 
Cut All - Del Topic to place the topic text on the Clipboard and to delete the topic.  Then select the topic to 
which you want to add the text, place the cursor where you want the text inserted, and choose Edit-Paste.

4.0  Detailed Program Instructions

Menu Commands 
All functions within the program can be executed from the menus.  Note a number of  shortcut keys are 
available.



Files Menu 

Import Text 
Select this menu item to import an ASCII file directly into Journal.  The file is added to the currently selected 
category.  The file text is added to the topic and the file name is added as the topic title.  Maximum file size 
that can  be imported is 30K.    

Export Text 
Select this menu item to export one of Journal's topics to a file.  When the menu item is selected you are 
prompted  for the filename where you want the file save.  The entire path must be specified or the file is 
saved in the current  directory.    

Backup Data Files 
This command will make backup copies, in the program directory, of the initialization file (journal.dat) and 
each of the data files.  If for any reason one of the files becomes corrupt, the backups may be used.  If any 
backup is used then THEY ALL MUST BE USED. To restore, copy each backup to the respective program
file (eg, journal.bak to journal.dat, anote.bak to anote.jou, etc). 
The program is VERY sensitive to the file structures.  These files CANNOT BE EDITED WITH ANOTHER 
EDITOR as this would corrupt the files structure.  For further information see the techical information in the  
About HelpABOUT section.

Remove Category to File 
This function will remove the selected Category from Journal and save it to disk.  Both the 
index of topic titles and the data are saved.  The titles are saved to file: categoryname.JTX 
and the data to categoryname.JTT.  These files are  located in the Program Directory.  This is an easy 
means to move categories from one computer to another:  remove them to file, copy both the JTX and JTT 
files to the new computer, and then Add Category on the new computer to add them back in on the new 
computer.  If you want to completely remove a category from Journal, remove it to file.  If you do not even 
want to save the data, then delete the respective JTX and JTT files.

Add Category from File 

This function will add a category back into Journal that has previously been removed.  
THIS WILL ONLY WORK FOR FILES PREVIOUSLY REMOVED FROM JOURNAL.  The 
data files must be located in the Program Directory.  After selecting this item, a dialog form 
pops up listing the Category files found which can be added back into Journal.  Select the 
category desired by either highliting the item in the Listbox and pressing the OK Button or by 
double-clicking the Category Name in the Listbox.   Journal will automatically size the maximum capacity of 
the category large enough to hold the category.

The Category button to which you want to bring the Category from disk MUST be an empty category. 

Use of the Remove Category to File and Add Category from File function is 
that it provides a good way to move selected categories between computers.  For example, 
if you have the program installed both at home and at work; these two functions provide an 
easy way to move categories between the two computers, 

Additionally, if 8 categories is insufficient, additional categories may be created and saved 
to disk until needed. 

Topic List Width

Selecting this menu item allows you to set the Topic List Width as a percentage of the total form width.  
Journal comes configured with the Topic List Width set at  25% of the total form width.  If this is changed, 
Journal "remembers" the change from session to session.  To change the width percentage, click the menu 
selection desired.

Choose Printer Font

Selecting this menu, brings up a standard Windows font selection dialog.  This font ONLY applies to the 
printer.  Bold and Italic, though available on the dialog, are NOT sent to the printer.  Journal "remembers" 



Printer Font selections from session to session.

Choose Screen Font

This selection is used to select the screen font to be used in the Topic Titles Listbox and the Topic Text box.  
If you want these fonts in Bold or Italic, these must be selected (Bold often looks better on the screen but is 
slightly wider than regular.  Italic is NOT recommended as it is too wide.  Journal "remembers" selections 
from session to session.

Topics Menu 

All commands associated with individual topics are located on this menu selection.  Note the shortcut keys.  
Categories can be thouoght of as file drawers, while the topics are individual files within these drawers.  The 
topic title is the name of the file and is always displayed in the listbox to the left for selection.  Commands 
are available to permit easy storage of information and easy maintenance.  Two of the most used 
commands, New Topic and Delete are also available as buttons. 

Configure Categories 

This is used to configure the Category maximum data capacity, Category titles and the Category button, 
Switch and Transfer Menu labels.  When the item is selected, a separate form  opens for entering new titles 
or adjusting the data capacity for any category.  It is important to note that changing a Category Title (and  
corresponding button title) does not change any of the topics or topic text associated with that Category.  
Thus you  can change Category Titles any time desired. The maximum length of the title is limited to 8 
characters.  Data capacities may be set from 250 KB to 4 MB.

For fastest switching between categories within Journal, set each of the categories to the SAME size.  For 
least effect of the speed of switching between other Windows programs, have at least one category set to 
250KB and switch to that category before leaving Journal.  Regardless, since it is so easy to change the size
of a category, you should configure to the smallest size that will accommadate the data (remember, for 
fastest switching between categories WITHIN Journal, configure all to the same size)

Clicking on Configure Categories brings up the following dialog:

Listed on this form are the 8 categories for configuring.  Four columns, NAME for the category name (this 
appears as the category label), Current Data Size, Current Capacity, and horizontal scrollbars to adjust the 
maximum capacity for each individual category.

Name Column:  To change the name of an individual category, click in the Name text box for the category 
and type the desired name.  Only the first 8 characters are used.

Data Size Column:  This is the current size of the data for the category.  This is measured by measuring the 
size of the data file on disk.  This value CANNOT be changed, it is displayed for information.

Capacity Column:  This is the currently set maximum capacity for the category.  This value is set using the 
scrollbars.  The minimum value cannot be set lower than that value needed to hold the data currently 
contained in the category, other than that restriction, the maximum data range can be set from 250 KB to 4 
MB (4000KB). 

Horizontal Scroll Bars:  These are used to adjust the individual maximum capacity for each category.  
Clicking the left arrow decreases the maximum capacity, the right arrow increases the maximum capacity.  
You cannot set the maximum size smaller than what is required to hold the data in the category.  Journal 
"remembers" these settings from session to session.

Help on this form is available by clicking the ? box.

New topic     Shortcut:  ctrl + N 
This functions exactly the same as the New Topic button.  A title box is opened to type in the title of the topic.
Topic titles can be up to 45 characters.  The date the topic is created is automatically 9defulat mode) 
appended to the start of the  title.  The topic title is then added is the topic listbox and the cursor is placed in 



the text box for entering the  associated text. 

Delete Topic     Shortcut:  ctrl + D 
This item is utilized to remove a topic from Journal.  It functions exactly the  same as the Delete Topic 
button.  The  topic title is removed from the listbox, the topic text is deleted, and the remainder of topics 
adjusted in position (the  remainder of the topics are rolled up) 

Edit Topic Title 
This is utilized to edit the selected title.  The title is presented in a dialog box.  A new title can be typed or the
existed one edited.  The date is NOT automatically appended.  Note, the entire title text is highlited in the 
dialog box presented.  Typing replaces all text.  If you only want to edit the title, then you must press one of 
the arrow keys or clilck the mouse within the title to remove the highliting. 

Print topic     Shortcut:  ctrl + P 
Selecting this item prints the current topic.  The topic title is printed as a header. 

Save Topic Data 
This functions the same as the SAVE Button.  All program data is saved. 

Date Stamp On 
If this button is checked, default mode, then today's date is automatically appended to topic titles.  A 
checkmark appears in the menu next to this item when it is ON.  To turn off the automatic date stamping, 
click the menu item and the checkmark will disappear.  Date stamping will stay off for the remainder of the 
session unless turned on.  Whenever the program starts, it starts with date stamping ON. 

Daily Journal Topic     Shortcut:  F4

This selection will add a new topic in the format of MM/DD DAY Daily Notes (eg 12/25 Mon Daily Notes).  If 
you leave the first category configured to hold daily notes; at start up press the F4 key and a topic will be 
added to hold the daily notes.  Holding all of these in one category provides an excellent way to retrieve the 
information.  The Listbox selection can be used to quickly retrieve the notes for any given day.  The Find - 
Text Search provides a quick way to retrieve any given subject.

First Cat, Last Topic  Shortcut:  F3

This selection permits you to move to the last topic in the first category quickly from anywhere in Journal.  
Pressing the F3 key takes you to the last topic in the first category.  If you use the first category to hold daily 
notes, this is a quick way to get to today's note topic.

Edit Menu 
The Edit Menu provides the normal windows Clipboard editing functions, Cut, Copy, Paste and Delete.  In 
addition,  three added functions are provided:  STRIP CrLF strips CrLfs from selected text,  COPY ALL 
copies the entire topic text to the Clipboard.  COPY ALL - DEL  TOPIC copies the entire topic text to the 
Clipboard AND then deletes the topic. 

Cut     Shortcut:  Shift + Delete 
This cuts the selected text from the topic text and places it on the Clipboard. 

Copy      Shortcut:  Ctrl + Insert
This makes a copy of the selected text and places it on the Clipboard. 

Paste      Shortcut:  Shift + Insert
This inserts the text on the Clipboard into the topic text at the point where the cursor is located. 

Strip CrLf     Shortcut:  ctrl + Z 
Selecting this command will remove  ALL CrLfs from the  selected text.  This is useful when text is brought 
into Journal, either via Inport or the Clipboard, which has embedded carriage return-lilne feeds.  Place the 
mouse at the start of the text, hold down the left button and drag over the desried text.  After releasing the 
mouse button, select this menu item or use the shortcut key, ctrl + Z. 

Copy All 
This will copy the entire text from the topic and place it on the Clipboard.  No change is made to the topic 



text.  This  function is most useful to make a copy of the topic text to place into another document or to make
a copy of a topic  and place it in another category. 

Cut All - Del Topic 
This will copy the entire text from the topic and place it on the Clipboard.  After placing it on the Clipboard, 
the topic  is deleted.  CAUTION should be exercised, since the topic is deleted, the text should immediately 
be pasted in  either another application or another topic.  This function is most useful to combine the text 
from two topics together.   Select the topic you want to delete, then select COPY ALL - DEL TOPIC, then 
select the topic where you want to  place the text, place the cursor where the text is to be inserted, and 
select PASTE to insert the text. 

Find Menu

This is used to search the data base.  The search can be Case Sensitive(fastest search) or Case 
Insensitive(most complete search).  When this menu item is selected a separate dialog form opens for the 
search data.  The search dialog permits two types of searchs:  Titles Search, a search of all Titles contained 
in the database or Text Search, a search of all text in all topics of the currently selected category.

A maximum of 50 "FINDS" can be made.  If the FOUND caption is 50, it likely there are more instances of 
the search word in the database.  The search should be repeated with more restrictive search criteria.

Titles Search:  This search looks for the search text in each title contained in the data base.  When found,
the title is added to the listbox.  In front of the title is two numbers. The first, 1 to 8, is which category the 
item was found in (the categories are numbered 1 to 8, left to right).  The second number is the number of 
the topic in that category (the topics are numbered from top down).  To see one of the items, click on the title
in the listbox.  Journal will then switch to the category and display the topic.  If that is not the one desired, 
simply click another title.

Text Search:  This search looks for the search text in all topic text in the currently selected category.  One 
number is shown in front of the topic title in the listbox, the topic number.  To see a topic, click the title in the 
listbox; Journal will switch to that topic, highlight the word in the text, and turn off the Search dialog box.  If 
that is not the one desired, simply click the menu Find, the dialog box re-appears and another topic title may 
selected.  In addition, if it is the correct topic, but you want to find another occurance of the search text in the
SAME topic, click the Find Menu to bring the Search form back up and then click the NextText button 
(SHORTCUT:  Just press the F5 function key while still in the topic text field).  This finds the next occurance 
of the search text in the SAME topic.

Clicking Find brings up the following dialog:

Search For:  This input box is used to enter the search string desired.
Case Sensitive:  If this box is checked, a Case Sensitive search is conducted.  If you want a case 
insensitive search, uncheck this box.
Found:  This label shows the number of topics found containing the search text.  Journal can find a 
maximum of 50 finds, if the Found label is 50, it is likely there are more instances of the search text in the 
data base.  The search may be repeated with more restrictive search data (larger string, Case Sensitive, 
etc).
Title Search:  This button is used to conduct a search of all topic titles in the data base.
Text Search:  This button is used to conduct a search of all topic text in the currently selected category.
Next Text:      Shortcut: F5    This button is used to find the next occurance of the search string in the SAME 
topic as currently displayed.
Done:  The Done button hides the form.

Switch Menu 
This menu item functions exactly the same as the buttons across the top of the screen, they permit switching
to another Category.  Select the Switch Menu, then click the Category title to which you want to switch. 

Transfer Menu 
This function is used to transfer a topic from one category to another.  To transfer a topic, select the topic 



you want  to transfer, then select the transfer menu, then select the category to which you want to transfer 
the selected topic.   The topic is then deleted the old category and transferred to the newly selected 
category.  Within the new category,  the topic is appended to the end of the topic list in that category.  The 
title is appended as it was in the old category. 

Exit Menu 
Selecting this item will end the program and save all data files.  Before ending, you are prompted to Make a 
Backup of Data Files.  Unless there is some reason to the contrary, this should always be selected.  This 
program data file structures are extemely critical to proper performance. 

Help Menu 
Clicking this item will bring up this help menu.  All of the text in this Help file is set for browsing throughout. 
This permits reading of the Help much like reading a manual. 

5.0  Keyboard Commands 
The most used commands are available as buttons in the upper portion of the program screen.  In addition, 
two labels indicate how many topics are contained in the currently selected Category and the size of text in 
the currently selected topic.  Maximum number of topics is 400.  Maximum topic text size is 30K. 

Categories 
The eight buttons across the top are used to switch between categories.  The Set Categories selection 
under the Topics MenuTOPICS is used to set the individual Category titles.  These titles are displayed as the
button captions, as well as on both the Switch and Transfer menus. 

New Topic 
This button is used to add a new topic to the Journal.  When the button is clicked, a promt appears for the 
topic  title.  The title is limited to 45 characters.  The date the topic is created is automatically (default mode) 
appended to the beginning  of the topic title. 

Delete Topic 
This button is used to remove a topic from  Journal.  When pressed, the selected topic title is removed from 
the llistbox and the  corresponding text deleted.  the remainder of the topics is rolled up to fill in the gap. 

Save Button 
Clicking this button saves all of the program data to disk. 

6.0  Shortcut Keys 
ctrl + C     Copy All 
ctrl + D     Delete Topic 
ctrl + N     New Topic 
ctrl + P     Print Topic 
ctrl + S     Save Topic Data 
ctrl + T     Edit Title 
ctrl + X     Cut All-Del Topic 
ctrl + Z     Strip CrLf 
F5 Next Text Search

7.0  DailyClp Button 
At startup this button is located in the upper right corner of the screen.  The button can be moved to any 
desired location by moving the mouse over the title bar, and while holding down the left mouse button, drag 
to the desired location.  Journal "remembers" this location from session to session.  This button cannot be 
reduced to an icon.  Only the actual command button and the title bar is displayed.  A single click of the 
button performs the following: 

-  checks to ensure there is text on the Clipboard 
-  grabs the text from the Clipboard and displays the size in KBytes as the new form title 
-  Opens a dialog box prompting for the new topic title or for the topic to append
-   Pastes the text into the topic 



Text on the Clipboard can be added as a new topic or appended to an existing topic within the currently 
selected category.  The currently selected Category is displayed as the title, so even if Journal is in an icon, 
the text under the icon is the title of the curently selected category. When the dialog box pops up, you can 
type in a new title or accept the default (first 45 characters of the Clipboard), and click the OK button to add 
the Clipboard text as a new topic.  You can also select the Append Button to append the CLipboard Text to 
an existing topic.  

If the button is accidently clicked and you do not want to paste text, in the dialog box that pops up simply  
select the CANCEL button.

This button is very useful for adding information to Journal from other programs.  Simply place the text  on 
the Clipboard, click the DAILYCLP button, type in the topic title or select a topic to append to, and the 
Clipboard text is added.  Many programs offer shortcuts for selected all text.  This makes it easy to copy the 
entire text to the  Clipboard.  For example, in Microsoft Word for Windows, holding down the control button 
and clicking in the left  column will select the entire document.  Then pressing the EDIT - Copy menu 
selection (or the button on the  toolbar) will copy the entire text to the Clipboard.  With the text on the 
Clipboard, click the DAILYCLP button.  The  size of the text is displayed in the title (Journal has a maximum 
limit of 30K per topic) and a dialog box pops up for  the topic title.  Individual application documentation 
should be checked for shortcuts to copy text to the Clipboard. 

Clicking the DailyClp button brings up the following dialog:

This dialog is used to either add the Clipboard as a new topic or to append it to an existing topic.  The form 
comes up for a new title.  If you desired to Append, click the Append Button.  The New Topic portion 
disappears and the Append portion appears.  In the Append form, a listbox is shown with the Topics from the
current category shown.  Click the title desired and click the OK button to append.  When Appending, a 
check is made  to ensure no more than 30K is contained in a given topic.

New Topic Form
When the new topic form is displayed, the Clipboard text is added as a new topic.  You can either accept the
default title or type a new title in the Title Text Box.  To add, click the OK button.  To cancel, click the Cancel 
Button.  If you want to append, click the Append Button, and the following dialog appears:

Append Form
The Append form is used to append the text to an existing topic.  The currently selected topic is shown in the
box at the top of the form. To select a new Topic Title, click the title and it will move to the selected topic box. 
When the desired title is displayed, click the OK button to append the text.  If you want to cancel, click the 
Cancel Button.  The New Topic Button will return you to the New Topic Form.
The button can be move to any location on the screen by placing the mouse in the title bar, holding down  
the left mouse button, and dragging to the desired location. 

8.0  How to .... 
Use as a Personal Information Manager (PIM)

Because of the powerful search functions, Journal is very adaptable as a free-form PIM.  
Essentially, every word, both in the titles and the text, can be considered as "keywords" since you can 
search for any throughtout the database.  To quickly retrieve, assign search keywords to information, eg 
[phone] to phone numbers, [address] for addresses, [action] for action items, [due] for due items, 
[due]23/6/92 for specific due dates, [idea] for ideas, etc.  Projects can be organized as separate topics.  
Then, using the Find features, these items can very quickly be retrieved.  By storing them in one category, 
you also have the Text Search features to find items within individual categories.

Special shortcut keys, F4 to add a Daily Notes Topic and F3 to take you to the last topic in the first 
category, makes the first category an excellent category to hold a daily notes Journal.  The first time you 
want to add a daily note, switch to the first category and press the F4 function key.  This will add a topic 
using the day's date.  If this is left as the last topic (no more topics added after this one), then from anywhere
in the program, pressing the F3 key will take you to this topic.

One recommended configuration is to leave the first category configured as DailyJou and configure
the second as PIM.  Remaining categories can be configured as specific areas, for example: 



Visual Basic programmers:  The third as VBNotes for various notes collected on subject related to 
VB and the fourth VBProgs for form and module program code listings.

Program Managers:  The third as Program (name of the program) for holding information about 
their program, the fourth as Regs for holding policy and guidance for managing the program, the fifth as 
Team for holding information about their staff and supporting team members.  Action items, telephone 
numbers, due dates, etc would all be stored in PIM.

Use as a Programer's Tool
For the programer, Journal provides an excellent means to store notes on various subjects and for 

storing the program code listings.  Using the Find features, this information can be quickly retrieved.  For 
example, I store all Visual Basic code listing in one category.  I can quickly find the Form_Load code for 
programs by searching the category for Form_Load and then selecting the program from the titles list.  Code
can be copied to the Clipboard and pasted into my Visual Basic program.  Another category is established 
as program notes.  In this I put the various notes I collect from sources such as CompuServe MSBASIC 
Forum, CIS Mail, scanned articles, etc.

Add new topics
There are three ways to add new topics to a given Category.  If you want to type the information 

into the topic, select NEW TOPIC.  Click on the DAILYCLP button to add a new topic and place the text from
the Clipboard into the topic.  When you click this button you will be prompted for the topic Title.  And third, 
ASCII files less than 30K can be directly imported using the FILES Menu, Import function.  Selecting this 
function opens a standard Windows file open box.  
Add new Categories

Under the Topics Menui, select SET CATEGORIES.  A separate screen comes up in which you can
type the Category name on the button you desire.  If all of the buttons have been used, then you must first  
remove one of the categories to disk.  This will free up a button.  On the free button, type up to 8 characters 
of text.
Remove a Category but save it to Disk

Click the button of the category you want to remove.  Then under the FILES Menu, Click Remove 
Category to File.  This will automatically save the category to disk with the filename equal to the category 
name that was used.  Using this featture you can actually have more than 8 categories, an unlimited 
number, but you can only have 8 open at any one time in Journal.  The first category, DailyJou can never be 
removed to file.
Add a Category fm Disk

FIrst you must select a category button that is currently empty.  You can not add one category over 
the top of another one.  Under the FILES Menu, click ADD CATEGORY fm FILE.  A screen appears listing 
the category files currently stored on disk.  Either double click the file name or click once on the file name 
and click the OK button.  This will restored the category to Journal.
Add an Electronic Mail Message to Journal

Within the electronic mail program select the message text and copy this text to the Clipboard.  
Without closing the electronic mail program, simply click the DAILYCLP button.  This will then prompt for the 
title you want for this topic.  The topic is then added to the CURRENTLY SELECTED CATEGORY adding 
both the title and the Clipboard text to the topic text.  

9.0  About and Technical Info 

Author 
Gordon Smith 
341 RiverBend Road 
Great Falls, VA 22066 
703-759-4415 
CompuServe 72567,3416 
Resources: 
JOURNAL was written using Microsoft Visual Basic (VBRUN100.DLL required), the Microsoft Visual Basic 
Professional Toolkit (Threed.vbx required) and MicroHelp Muscle (Muscle.Vbx required).   The Muscle.Vbx 
and Threed.vbx runtime libraries distributed  CANNOT be run from within the Visual Basic environment. 

The titles for all topics in all categories, along with the size of the text field with each,  is stored in the file 
JOURNAL.DAT.  The text data for the topics is stored in separate files: ANOTE.JOU thru HNOTE.JOU.  The 
backups for these files are the same name with the extent .BAK.  When categories are saved to file, the 
topic titles and the size of the respective text fields for the category are written to CATEGORYNAME.JTX, 



where CATEGORYNAME is the category name assigned within Journal.  The text data is stored in 
CATEGORYNAME.JTT.  These files can be moved, together, from computer to computer but THEY CAN 
NOT BE ALTERED BY ANOTHER PROGRAM.

10.0  DEFINITION OF SHAREWARE

Shareware distribution gives users a chance to try software before buying it.  If you try a Shareware program
and continue using it, you are expected to register.  Individual programs differ on details -- some request 
registration while others require it, some specify a maximum trial period.  With registration, you get anything 
from the simple right to continue using the software to an updated program with printed manual. 
Copyright laws apply to both Shareware and commercial software, and the copyright holder retains all rights,
with a few specific exceptions as stated below.  Shareware authors are accomplished programmers, just like
commercial authors, and the programs are of comparable quality.  (In both cases, there are good programs 
and bad ones!)  The main difference is in the method of distribution.  The author specifically grants the right 
to copy and distribute the software, either to all and sundry or to a specific group.  For example, some 
authors require written permission before a commercial disk vendor may copy their Shareware.

Shareware is a distribution method, not a type of software.  You should find software that suits your needs 
and pocketbook, whether it's commercial or Shareware.  The Shareware system makes fitting your needs 
easier, because you can try before you buy. And because the overhead is low, prices are low also. 
Shareware has the ultimate money-back guarantee -- if you don't use the product, you don't pay for it. 
DISCLAIMER - AGREEMENT

Users of JOURNAL must accept this disclaimer of warranty: "JOURNAL is supplied as is.  The author 
disclaims all warranties, expressed or implied, including, without limitation, the warranties of merchantability 
and of fitness for any purpose. The author assumes no liability for damages, direct or conse- quential, which 
may result from the use of JOURNAL." 
JOURNAL is a "shareware program" and is provided at no charge to the user for evaluation.  Feel free to 
share it with your friends, but please do not give it away altered or as part of another system.  The essence 
of "user-supported" software is to provide personal computer users with quality software without high prices, 
and yet to provide incentive for programmers to continue to develop new products.  If you find this program 
useful and find that you are using JOURNAL and continue to use JOURNAL after a reasonable trial period, 
you must make a registration payment of $25.00 to Gordon Smith.  The $25.00 registration fee will license 
one copy for use on any one computer at any one time.  You must treat this software just like a book.  An 
example is that this software may be used by any number of people and may be freely moved from one 
computer location to another, so long as there is no possibility of it being used at one location while it's being
used at another. Just as a book cannot be read by two different persons at the same time. 
Commercial users of JOURNAL must register and pay for their copies of JOURNAL within 30 days of first 
use or their license is withdrawn. .

Anyone distributing JOURNAL for any kind of remuneration must first contact Gordon Smith at the address 
below for authorization. This authorization will be automatically granted to distributors recognized by the 
ASP as adhering to its guidelines for shareware distributors, and such distributors may begin offering 
JOURNAL immediately (However Gordon Smith must still be advised so that the distributor can be kept up-
to-date with the latest version of JOURNAL.). 

You are encouraged to pass a copy of JOURNAL along to your friends for evaluation.  Please encourage 
them to register their copy if they find that they can use it. 

Although the author is not yet a member of ASP, Journal is a Shareware program conforming to standards 
as established by the Association of Shareware Professionals (ASP) located at 325  118th Ave.  S.E., Suite 
200, Belleview, WA 98005.  The author will provide the following support:

-  Telephone support to registered users
-  Support via mail, all letters sent will be answered
-  Electronic mail support via Compuserve (Acct 72567,3416)  (preferred method)
-  This is a fully functioning product with no crippling
-  There are no undocumented features
-  The program has been throughly tested.

Although this  program is produced by a non-member of the Association of Shareware
Professionals (ASP), the ASP standards and principals are fully supported and the author will comply with all
ASP standards and practices.  ASP wants to make sure that the shareware  principle works for you. If you 



are unable to resolve a  shareware-related problem with an ASP member by contacting the member
directly, ASP may be able to help. The ASP Ombudsman can help you  resolve a dispute or problem with an 
ASP member, but does not provide  technical support for members' products.  Please write to the ASP
Ombudsman at 545 Grover Road, Muskegon, MI 49442 or send a CompuServe  message via CompuServe 
Mail to ASP Ombudsman 70007,3536.

11.0  COPYRIGHT     
© Copyright 1992 Gordon L. Smith. All Rights Reserved. This document may not, in whole or part, be copied, 
photocopied, translated, or reduced to any electronic medium or machine readable form, without prior consent, in writing, 
from Gordon L. Smith. All software described in this manual is © Copyright 1992 Gordon L. Smith. All rights reserved. The 
distribution and sale of these products are intended for the use of the original purchaser only. Lawful users of these 
programs are hereby licensed only to read the programs, from their media into computer memory, solely for the purpose 
of executing the programs. Duplicating or copying for other than backup purposes, selling, or otherwise distributing these 
products, is a violation of the law and this agreement. 

DISCLAIMER 

THIS INFORMATION IS PROVIDED "AS IS" WITHOUT REPRESENTATION OR WARRANTY OF ANY KIND, EITHER 
EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY REPRESENTATIONS OR ENDORSEMENTS 
REGARDING THE USE OF, THE RESULTS OF, OR PERFORMANCE OF THE INFORMATION, ITS 
APPROPRIATENESS, ACCURACY, RELIABILITY, OR CORRECTNESS. THE ENTIRE RISK AS TO THE USE OF THIS 
INFORMATION IS ASSUMED BY THE USER. IN NO EVENT WILL GORDON L. SMITH BE LIABLE FOR ANY 
DAMAGES, DIRECT, INDIRECT, INCIDENTAL OR CONSEQUENTIAL, RESULTING FROM ANY DEFECT IN THE 
INFORMATION, EVEN IF GORDON L. SMITH HAS BEEN NOTIFIED OF THE POSSIBILITY OF SUCH DAMAGES. 
THIS DISCLAIMER SHALL SUPERSEDE ANY VERBAL OR WRITTEN STATEMENT TO THE CONTRARY. IF YOU DO 
NOT ACCEPT THESE TERMS YOU MUST CEASE AND DESIST USING THIS PRODUCT IMMEDIATELY. 

LICENSE AGREEMENT 

Your use of this package indicates your acceptance of the following terms and conditions: 

1. Copyright: These programs and the related documentation are copyright. The sole owner is Gordon L. Smith. You may
not use, copy, modify, or transfer the programs, documentation, or any copy except as expressly provided in this 
agreement. 

2. License: You have the non-exclusive right to use any enclosed program. You may load the program into your 
computers temporary memory (RAM). You may distribute copies of the complete package or the accompanying 
documentation to others. You may not decompile, disassemble, reverse engineer, modify, or translate the program or the 
documentation. You may not attempt to unlock or bypass any copy protection utilized with the program. All other rights 
and uses not specifically granted in this license are reserved by Gordon L. Smith. 

3. Back-up and Transfer: You may make copies of the program, but you must reproduce and include the copyright notice
on the copies. You may transfer the product to another party only if the other party agrees to the terms and conditions of 
this agreement and completes and returns a registration card to Gordon L. Smith.  

4. Terms: This license is effective until terminated. You may terminate it by destroying the program, the documentation 
and copies thereof. This license will also terminate if you fail to comply with any terms or conditions of this agreement. You
agree upon such termination to destroy all copies of the program and of the documentation.

NOTE:  WINDOWS, WINDOWS 3.1, and Clipboard  ARE ©1992 MICROSOFT CORPORATION. 


